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Abstract
The prevalence of distance education utilizing asynchronous instruction has increased in recent years. Asynchronous instruc-
tion differs from the more common synchronous instruction in that learners primarily contact the lessons and educational 
materials on their own rather than with a live instructor. Though not without its limitations, asynchronous instruction offers 
a variety of advantages that can make instruction more efficient, produce better outcomes, and increase accessibility to a 
greater variety of learners if created using known principles of effective instructional design. Though many platforms exist 
for creating asynchronous instruction, these are often accompanied by barriers to their widespread use. A potential cost-
effective and flexible alternative to these is Microsoft®  PowerPointTM. The present report serves as a guide for creating 
interactive and responsive asynchronous instructional sequences with PowerPoint for Microsoft 365® using principles and 
procedures derived from programmed instruction (Skinner, 1968). Ideas for additional response types are also provided, as 
are the limitations of designing instructional sequences with this software. Previous papers on the use of PowerPoint as an 
instructional tool have been primarily geared towards instruction for young learners or learners with autism. As such, the 
present article expands on the use of PowerPoint specifically to higher education.

Keywords Asynchronous instruction · Programmed instruction · Computer-based instruction · Distance education · 
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The last decade has seen an increase in alternatives to tra-
ditional on-ground learning experiences in higher educa-
tion (Allen & Seaman, 2017). One of the most prevalent of 
these alternatives is commonly known as distance learning 
or distance education, which refers to “Education that uses 
one or more technologies to deliver instruction to students 
who are separated from the instructor and to support regu-
lar and substantive interaction between the students and the 
instructor synchronously or asynchronously” (Hussar et al., 
2020, p. 133). The U.S. Department of Education National 
Center for Education Statistics found that in fall 2018, 34% 
of undergraduate students and almost 40% of postbacca-
laureate students were engaged in some form of distance 
education, representing an increase of roughly 113,300 
students from the previous year (Hussar et al., 2020). The 
prevalence of distance education further increased during 

the 2020–2021 COVID-19 global pandemic, which saw 
many brick-and-mortar higher education institutions halt 
in-person classroom learning in favor of these alternative 
methods (National Student Clearinghouse Research Center, 
2021).

One commonly used method for delivering instructional 
content in distance education is asynchronous instruction, a 
method in which students complete lessons and educational 
materials on their own without a live instructor. This differs 
from synchronous instruction in which students interact with 
educational material with an actual instructor live and in 
real-time, though with the advent of video conferencing soft-
ware, synchronous instruction no longer implies in-person 
instruction. Asynchronous instruction has been shown to 
be effective for teaching and learning various concepts and 
principles for a variety of learners, including parents of chil-
dren with autism spectrum disorder (Blackman et al., 2020; 
Jang et al., 2012), behavior therapists (Granpeesheh et al., 
2010), teachers (Higbee et al., 2016), and undergraduate and 
graduate students (Blair et al., 2021; Davis et al., 2007; Root 
& Rehfeldt, 2021).
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Asynchronous instruction is not limited, however, to 
the acquisition of broad knowledge in academic contexts. 
Practitioners have also successfully utilized asynchronous 
instruction to help learners develop a wide variety of spe-
cific skills and repertoires, including greeting others with 
their names (Ingvarsson & Hanley, 2006), reading braille 
characters (Scheithauer & Tiger, 2012), accepting feedback 
(Walker & Sellers, 2021), using safety skills (Vanselow & 
Hanley, 2014), running discrete trial training (Geiger et al., 
2018; Pollard et al., 2014), implementing behavior reduc-
tion and acquisition programs (Fisher et al., 2014; Mailey 
et al., 2021), conducting stimulus preference assessments 
(Lipschultz et al., 2015; Vladescu et al., 2021), analyzing 
graphical depictions of data (O'Grady et al., 2018; Retzlaff 
et al., 2020), collecting information for functional assess-
ment (Scott et al., 2018), and conducting functional analyses 
(Schnell et al., 2018).

Advantages and Limitations 
of Asynchronous Instruction

Asynchronous instruction offers both learners and instruc-
tors many advantages. For one thing, asynchronous instruc-
tion provides potentially greater access for individuals who 
are not able to pursue additional educational opportunities, 
including learners with families, learners who must work 
full time, and learners who do not live in close geographic 
proximity to educational institutions (Fadde & Vu, 2014). 
Asynchronous instruction may also be beneficial for many 
neurodivergent learners and learners who have encountered 
systemic barriers to success in traditional Western class-
room settings, because the flexible nature of asynchronous 
instruction allows individuals to step away if they become 
overwhelmed, slow down or repeat presented information 
for easier consumption, and interact with the material in 
chosen environments that are comfortable, supportive, and 
free of distraction and judgement.

In addition, the use of predeveloped asynchronous con-
tent can help ensure consistency across instructors and dif-
ferent sections of a given course, ensuring that all learners 
contact the instruction with the same degree of quality and 
fidelity. The scripted and planned nature of asynchronous 
lessons can also help reduce confusion and ambiguity in the 
materials, resulting in learners having fewer clarifying ques-
tions and greater confidence in understanding the content.

Asynchronous instruction is not without its limitations, 
however. Success with primarily asynchronous instruction 
requires learners to have a specific repertoire of skills relat-
ing to organization, time management, and self-discipline 
(Appana, 2008; Veletsianos, 2020). Furthermore, because 
of the separation between the learner and the instructor, 
asynchronous instruction can be susceptible to fewer overall 

opportunities for learners to receive feedback or to feedback 
that is too delayed to have a true effect on the learners’ per-
formance (Pappas, 2015). Asynchronous instruction, par-
ticularly that which relies on e-learning, can in some cases 
also be less accessible to individuals with limited access to 
technology or internet options, or to those with minimal skill 
sets surrounding efficient technology use. Furthermore, there 
is some content that may not be best suited for acquisition 
via asynchronous instruction, such as driving a car or per-
forming a medical procedure, though this limitation is likely 
to be eliminated as technology further advances (Taylor, 
2002). Finally, asynchronous instruction, if developed with-
out forethought, can be implemented in an ableist manner. 
Ableism refers to any practice, policy, or pattern of behavior 
that devalues, discriminates against, and designates as inher-
ently inferior disabled individuals (Dolmage, 2017; Shyman, 
2016). Ableism can manifest in a variety of ways during 
asynchronous instruction, such as an incompatibility with 
text-to-speech software, a lack of image labels, low-contrast 
color schemes, lack of sufficient closed captioning or written 
transcripts of audio narration, or an overabundance of text, 
images, and other sources of stimulation (Miller, 2014). The 
advantages afforded by asynchronous instruction, however, 
arguably outweigh these limitations, especially if properly 
accounted for in the initial development of the instruction.

Asynchronous Programmed Instruction

Asynchronous instruction is also highly compatible with 
many forms of behavior-analytic instruction, particularly 
programmed instruction. Programmed instruction is per-
haps best associated with B. F. Skinner, though it existed 
in various forms prior to his involvement (Petrina, 2004; 
Pressey, 1950). Programmed instruction refers to a method 
for designing and presenting instruction with the purpose of 
bringing specific responses on the part of the learner under 
the control of specific antecedent stimuli (Skinner, 1968; 
Vargas & Vargas, 1991). The “programmed” part of this 
method refers to the idea that stimuli and the order in which 
they are presented have been carefully chosen and delib-
erately arranged to lead the learner through the sequence 
and ensure the greatest likelihood that they will meet the 
required performance goals when the instruction concludes.

Though it can be presented in a wide variety of formats 
and media, structurally programmed instruction includes 
several specific key features. Content occurs in intentionally 
selected steps or instructional units, referred to as frames, 
which consist of chunks of information often in the form of 
short sentences, statements, images, or diagrams (Markle, 
1969). Each frame should be small enough that the learner 
does not become frustrated by an overwhelming amount of 
new information but large enough that the learner also does 
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not become bored or uninterested (Vargas & Vargas, 1991). 
During the development of the instructional sequence, pro-
grammers take care to ensure that the learner is unable to 
provide a correct response based on irrelevant or nones-
sential features of the frame, increasing the likelihood that 
correct responding will come under control of the desired 
antecedent stimuli frame (Skinner, 1954).

Another important aspect of programmed instruction is 
the deliberate development and evaluation of the instruc-
tional sequence. Good designers of programmed instruc-
tion must determine the specific content that needs to be 
included, the best way to break the content down into logical 
and manageable chunks, the goals and objectives that are to 
be reached to indicate learning has occurred, and the specific 
types of responses that will be required. In addition, those 
implementing programmed instruction obtain data on the 
learners’ performance to evaluate the effectiveness of the 
instructional sequence. When the data suggest the sequence 
is ineffective, changes are made to the design, and evaluation 
occurs once more (Barrett, 2002).

Programmed instruction also requires the learner to 
make frequent responses throughout the lesson. This active 
responding is a critical feature that is often lacking in more 
traditional lecture-based methods of instruction (Vargas, 
2013). In the early teaching machines and programmed 
workbooks, active responding often took the form of fill-
in-the-blank style responses or selecting an answer from a 
list of options, though these days the response requirement 
is not limited to these formats (Miller & Malott, 2006). The 
responses required may be overt (i.e., their occurrence is 
detectable by others) or covert (i.e., their occurrence is only 
detectable by the individual emitting the response), though 
overt responses have the advantage of allowing the pro-
gram to identify whether correct responding has occurred, 
as well as whether the correct response occurred for the right 
reasons—that is, if it has come under the correct stimulus 
control (Markle, 1990). Although the exact response form 
does not necessarily matter as such, not all active responses 
are created equal. In programmed instruction, the responses 
must also be meaningful and directly relevant to the infor-
mation presented in the frame (Kritch & Bostow, 1998). 
Furthermore, the active responding component is more than 
simply a knowledge check or a quiz—the act of meaningful 
responding (and the subsequent feedback) is itself the pro-
cess by which individuals actually learn the material. For 
example, rather than requiring that learners simply select 
a definition that was previously stated in the lesson from 
a list obviously incorrect definitions, learners may instead 
be required to discriminate novel examples of the concepts 
presented in the lesson, or they could select a definition from 
several near-identical nonexamples. In this way, responses 
are more indicative of real understanding or demonstrate 
more meaningful application (Markle, 1990).

Another key component to the effectiveness of programmed 
instruction is the feedback provided immediately following 
the learner’s response indicating whether the response was 
correct or incorrect. This feedback is to function as a form of 
reinforcement, leading to an increase in the future frequency 
of correct responses and a decrease in the future frequency of 
incorrect responses (Markle, 1990). Feedback can also serve 
a more motivational function, encouraging learners that they 
are in fact learning and reducing any ambiguity regarding their 
progress or lack thereof (Moran, 2004).

When creating programmed instruction lessons, each 
frame is carefully sequenced such that the earlier frames in 
the sequence provide prerequisite content for later frames; 
at no point should the learner be required to emit a response 
for which they have not been prepared for (Skinner, 1958). 
However, as with all instruction, some errors in responding 
may be expected. Because the goal is to bring responses 
under the control of specific antecedent verbal stimuli, pro-
grammed instruction may use prompts and scaffolding to 
keep errors to a minimum and increase the likelihood that 
the learner will emit the desired responses (Vargas & Vargas, 
1991). These prompts are then systematically and gradually 
faded away to ensure that by the end of the instructional 
sequence, the learner is able to successfully respond exclu-
sively to the instructional content rather than to supplemen-
tal stimuli (Desrochers & Gentry, 2004).

In addition to the features described above, programmed 
instruction has several other notable aspects. Unlike typi-
cal classroom instruction, programmed instruction is self-
administered, meaning that a learner can interact with and 
progress through the sequence with little-to-no support from 
a teacher or instructor. This increases the accessibility of 
the lesson as it does not require a trained professional to 
administer and can be completed on the learners’ own time. 
In addition, programmed instruction is self-paced, mean-
ing that learners progress through the instruction at their 
own speed, regardless of how quickly other learners move 
through the material. This feature may prevent learners from 
being presented information for which they do not have the 
prerequisite repertoires and thus minimize the occurrence 
of cumulative dysfluency, which is often a concern when 
instruction is delivered to groups of learners (Lockee et al., 
2004). For more information on programmed instruction, 
see Barrett (2002), Markle (1969), Markle (1990), Mechner 
(1961), and Skinner (1968).

Methods of Asynchronous Instruction 
Delivery

Though prominent in the United States in the 1950s and 
1960s, programmed instruction fell out of favor in latter dec-
ades, stemming partially from the cognitive revolution in 
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psychology and from the commercialization of programmed 
instruction, which resulted in the mass proliferation of 
poorly designed and ineffective programmed materials. 
However, technology has advanced and become ubiquitous 
enough that programmed instruction may finally reach the 
prevalence Skinner and others had initially intended (Mar-
kle, 1983). There are many e-learning software packages 
such as Adobe Captivate® and Articulate Storyline 360® 
that allow the creation of highly customizable, fully interac-
tive lessons. Such software is flexible and powerful, though 
it can be cost-prohibitive, often running hundreds of dollars 
to purchase. In addition, these packages can have a rather 
steep learning curve to being able to utilize them to their 
full capability. Alternatives to e-learning software are web 
browser-based options such as Nearpod® (https:// nearp od. 
com/) or AhaSlides (https:// ahasl ides. com/). These options 
afford many of the same advantages as the more expensive 
software counterparts,  though in a more user-friendly man-
ner. Many browser-based systems are also free to use, at least 
for the base functionality. However, these can be limited in 
their ability for individualization and response options, and 
users are required to pay for more advanced features.

A final option is Microsoft PowerPoint. Although 
generally used for slideshow presentations, PowerPoint 
possesses many features that can allow for other means 
of presenting and contacting instructional content. Pow-
erPoint may be especially useful because many teachers 
and instructors already own it, and thus does not repre-
sent an additional cost. Furthermore, many instructors 
are already familiar with the components, functions, and 
layout of PowerPoint, thus minimizing the learning curve 
necessary to utilize it for asynchronous purposes. Sev-
eral other articles have described the use of PowerPoint 
and similar options as instructional tools, though these 
have been primarily geared toward instruction for young 
learners or learners with autism (Blum et al., 2009; Cum-
mings & Saunders, 2019; Mattson et al., 2020; Parette 
et al., 2009; Rehfeldt et al., 2004). Therefore, the purpose 
of the present article is to describe how PowerPoint can 
be used to create interactive, asynchronous programmed 
instruction lessons for use by general education learners. A 
full tutorial on the development and design of the instruc-
tional content itself is beyond the scope of this article. For 

more a more in-depth description of instructional design, 
see Bruce (1999), Gangé et al. (2005), Johnson and Street 
(2004), Layng (2019), and Tiemann and Markle (1990).

The task analyses provided herein are based on the Pow-
erPoint for Microsoft software created for PCs; although 
all of the steps described are also available through other 
versions as well as for PowerPoint for Macs, the specific 
placement of many of the features and formatting options 
may be different. Notable Mac-specific differences are 
indicated as notes below relevant figures throughout this 
article.

Creating Content Slides

The content slides within PowerPoint are roughly analo-
gous to the frames that make up sequences of programmed 
instruction. Each slide should therefore contain a chunk 
of information to be displayed to the learner and/or a 
response opportunity. Frames can take many forms and 
serve different functions, as seen in  the examples in 
Table 1 (Ellington, 1987; Markle, 1990).

Each of these different frame types can be created via a 
PowerPoint content slide. The steps for adding new con-
tent slides can be seen in Table 2 and Figs. 1 and 2.

Adding Response Options

Once all of the content slides have been added, the next 
step is to add a means for the learner to make responses. In 
PowerPoint, this is best done by requiring learners to select 
an answer from a given set of options or by requiring them 
to click a specific feature of a given stimulus. To create 
such response opportunities, custom buttons will need to 
be added to the slides, and each button will correspond to 
one of the answer options. Buttons can be shapes, text, or 
even images added to the slide. Once the buttons have been 
added, each will be hyperlinked to other specific slides in 
the sequence. The steps for inserting objects to function as 
buttons can be found in Tables 3 and 4 Figs. 3 and 4.

Table 1  Types of programmed instruction frames

Frame Type Function

Teaching frames Introduce key information such as definitions or critical and variable features of a concept
Exemplification frames Present and explain examples and nonexamples in reference to previous teaching frames
Practice frames Support learners in applying or using information from previous teaching frames
Switch point frames Lead learners to different branches of an instructional sequence based on specific responses
Review frames Gauge retention or information presented earlier in the instructional sequence

https://nearpod.com/
https://nearpod.com/
https://ahaslides.com/
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Creating Feedback Slides

As previously stated, clear and immediate feedback is critical 
to effective learning during instruction. Feedback can occur 
in several forms. Knowledge of result (KR) simply informs 
learners whether they are correct or incorrect. Knowledge 

of correct response (KCR) on the other hand tells learners 
if their response is correct or incorrect, as well as what the 
correct answer is. Elaborative feedback occurs when addi-
tional explanation is provided detailing why an answer is 
correct or incorrect. In delayed feedback, information about 
the correctness of the learner’s responses is not provided 

Table 2  Adding new content slides

Step Description

1. Click the “New Slide” button in the toolbar at the top of the screen.
2. Select the specific slide format you would like from the options provided. The blank slide option is often best as it allows instructors to 

create a frame exactly as they see fit.
If the blank slide option is used, text can be added using the following steps:

2a. Click the Insert tab at the top of the screen (Fig. 1).
2b. Click the “Text Box” button in the toolbar.
2c. Move the cursor to the slide in which the text should be added, then click and drag the mouse without releasing the mouse button to draw 

the text box.
2d. Type your desired text within the text box.
2e. Move the textbox to the desired location on the slide by clicking the outside edge of the text box, then dragging the cursor without releas-

ing the mouse button/track pad until the text box is in the desired location.
2f. Double click the text to highlight it.
2g. Click the Home tab at the top of the screen.
2h. Use the text formatting options to select the desired font style, size, and color (Fig. 2).

Fig. 1  Inserting a shape or text 
box into a slide

Fig. 2  Options for changing the 
color, font, and font size of text
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Table 3  Inserting shapes as buttons

Step Description

1. With the Home tab selected, click the “Shapes” button in the toolbar at the top of the screen.
2. Select the specific shape you would like to use as your button.
3. Move the cursor to the slide in which the shape should be added, then click and drag the cursor without releasing the mouse button/track 

pad to draw the shape to the desired length and width.
4. Once the desired shape has been inserted on the slide, move the shape by clicking on it and dragging the mouse without releasing the 

mouse button/track pad until the shape is in the desired location. Shapes can also be moved to a desired position using the arrow keys 
on the computer keyboard.

5. Adjust the size of the shape by clicking on it to reveal the formatting outline of the shape. Then, while clicking on one of the corners of 
the image, drag the mouse in or out without releasing the mouse button. To preserve the length/width ratio of the shape, click and drag 
one of the corners while holding the “Shift” key.

6. Click the newly drawn shape once to select it. This will open the Shape Format options in the toolbar (Fig. 3).
7. Click the “Shape Fill” button to change the interior color of the shape.
8. Click the “Shape Outline” button to change the color of the exterior edge of the shape.
9. Double click the mouse anywhere inside the shape. This will add a cursor in the middle of the shape.
10. Type the text you would like to include as part of your answer option. The font style, size, and color of the newly added text can be 

modified using the previously described steps for formatting text boxes.
11. Repeat these steps until shapes have been added for each answer option.

Table 4  Inserting images as buttons

Step Description

1. Click the Insert tab at the top of the screen.
2. Click the “Pictures” button in the toolbar.
3. Select the destination from which you would like to select your image (Fig. 4).
3a. Selecting the “This Device” option will allow you select image files that are currently saved on your computer. In Microsoft ® PowerPoint 

for Mac, select the “Picture from File” option.
3b. Selecting the “Online Pictures” options will allow you to select images from the internet. You can search for different types of images 

with this option as well. To select only from copyright-free images, select the “Creative Commons only” checkbox before searching for 
images.

4. Once the image is inserted onto the slide, use the steps for moving and resizing listed in the previous section.
5. To add a label or caption to the images, place a textbox below or near each image using the previously described steps for inserting text-

boxes.
6. Repeat these steps until images have been added for each answer option.

Fig. 3  Options for changing the 
color of an inserted shape or 
textbox
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immediately, but rather after a predetermined amount of time 
has passed or a designed number of responses have been 
emitted (Jaehnig & Miller, 2007).

Different feedback types may be more or less appropriate 
for different types of responses. For comparatively simple 
fill-in-the-blank style responses, KR or KCR may be suffi-
cient. For responses that require conceptual discriminations 
or application, elaborative feedback will likely be neces-
sary. For responses made in a frequency-building context as 
a means for developing response fluency, delayed feedback 
may be best so as to not impose any artificial ceilings or lim-
its on response rate (Binder, 2010). Regardless of the feed-
back type however, there should be one feedback slide per 
response option on each content slide (Figs. 5 and 6). Table 5 
outlines one way of formatting feedback slides Figs. 7 and 8.

Creating Custom Slide Arrangements Using 
Hyperlinks

Once all of the slides have been created, they then need 
to be sequenced together. There are at least three broad 
types of sequence arrangements (Fig. 9). In nonlinear 

arrangements, learners are granted a certain degree 
of freedom to navigate through the lesson; that is, the 
sequence of slide presentation is not wholly fixed. In 
general, learners begin from a central hub and are then 
able to progress through different content or topics in 
any order they would like (Chen, 2002; Hudson, 2018). 
By providing learners complete control over the order in 
which they contact the material, instruction may become 
more personalized, and learners may be more likely to 
remain engaged and motivated during instruction. The 
“discovery” nature of nonlinear instruction is also well-
suited for situations in which learners’ own academic 
or professional goals are directly tied to the informa-
tion provided in the instruction (DeRouin et al., 2004). 
Furthermore, many argue that learning does not always 
occur in a sequential fashion and can thus be maximized 
when instruction is made available in a nonlinear manner 
(Robberecht, 2007). However, the freedom characteristic 
of nonlinear arrangements can also pose challenges to 
learners who require structure, scaffolding, and guidance 
to avoid becoming overwhelmed by the available informa-
tion and to ensure that they are acquiring and understand-
ing the necessary information.

Fig. 4  Inserting a picture into 
a slide. Note. Stock images are 
only available in PowerPoint for 
Microsoft 365

Fig. 5  Sample feedback slide 
for an incorrect answer option. 
Note. Note the lack of a “Next” 
button on this slide, which 
requires the learner to make a 
correct response in order to pro-
gress through the instructional 
sequence

Clicking the Close bu�on 
will return the learner to 
the original slide.
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In linear arrangements, the order of content presenta-
tion is carefully selected, and learners all follow the same 
instructional path, ensuring that they are acquiring the 
necessary component knowledge and that responses are 
sufficiently shaped before moving to more advanced por-
tions of the lesson (Glaser, 1960; Markle, 1969). Linear 
arrangement may be useful when teaching brand new 
content that the learners are unlikely to have contacted 

before and when a majority of learners all possess roughly 
equivalent levels of prerequisite knowledge. Presenting 
content in a linear fashion can ensure that all learners con-
tact all parts of the lesson, limiting potential for misun-
derstanding that can result when leaners are able to skip 
ahead. In this way, the responsibility of ensuring learning 
is placed on more on the instructor’s careful sequencing 
of the instructional content rather than on the learners 

Fig. 6  Sample feedback slide 
for a correct answer option

Clicking the Next bu�on will 
take the learner to the next 
slide in the instruc	onal 
sequence.

Table 5  Formatting feedback slides

Step Description

1. Make a copy of the slide on which the learner made the response by right-clicking on the slide in the left-hand side of the screen and then 
selecting “Duplicate Slide” (Fig. 7).

2. Draw a rectangle using the previously outlined steps for inserting shapes. The feedback will be shown in this shape, so it should be large 
enough to fit all of the required feedback text.

3. If the newly inserted rectangle does not appear on top of the text or images on the slide, move it to the front using the following steps:
3a. Click on the rectangle.
3b. Click on the “Shape Format” button in the toolbar.
3c. Click the “Bring Forward” button and select the “Bring to Front” option from the dropdown menu that appears (Fig. 8).
4. Double click inside the rectangle to activate the cursor, then type in your feedback text. You can modify the style, color, and size of the 

text using the previously described steps for formatting text.

Fig. 7  Duplicating a slide
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themselves. However, linear arrangement may slow down 
learners who acquire knowledge and skills at a faster pace 
than others and encourage them to pay less overall atten-
tion during instruction.

In branching arrangements, learners contact the 
instructional material in different sequences based on 
their responding; that is, one response may result in one 
content slide while another response (e.g., an incor-
rect response) results in a different subsequent content 
slide. Branching arrangements may provide different 
instructional paths for the learner, may jump the learner 
ahead to different parts of the instructional sequence, or 
may provide remedial loops before placing the learner 
back in the original sequence (Crowder, 1962; Elling-
ton, 1987). Branching arrangements offer many of the 
advantages of both nonlinear and linear instructional 
sequences, providing both a more individualized yet still 
supported learning experience. Depending on the com-
plexity of the instructional sequence and the number of 
different branch points, this type of arrangement can 
result in completely unique instructional experiences 
for different learners. However, branching arrangements 
can be challenging to develop as instructors must keep 
track of how each branch relates to the others, as well 
as manage the various points at which each branch will 
stem. This can result in branching arrangements taking 
significantly more time to create compared to the other 
arrangements, with more potential places for the instruc-
tional sequence to breakdown.

PowerPoint can create any of these instructional arrange-
ments through the careful use of hyperlinks to stitch together 
disparate slides. Clicking a button with a hyperlink results in 
the learner immediately advancing to a specific slide in the 
presentation. Table 6 shows the steps for adding hyperlinks 
Fig. 10.

Adding Custom Navigation Buttons

In order to properly progress through the instructional 
sequence, learners will need additional navigation but-
tons. Each content slide should include a “Back” button 
to allow to learners to return to the previous content slide 
if necessary. Each feedback slide should include a “Next” 
button to allow learners to advance to the next content 
slide. By only placing “Next” buttons on feedback slides 
rather than on content slides, learners are required to make 
some kind of response on each content slide in order to 
move on, helping to ensure responding remains active and 
intentional.

Instructors may also include a “Close” button on feed-
back slides that will return the learner to the current content 
slide to which they just made a response. This may be par-
ticularly beneficial when instructors would like learners to 
respond on a given slide until they are correct, or for learn-
ers who would like to see the original content slide again 
with the previously received feedback in mind. Finally, non-
linear instructional sequences may also include a “Home” 
button to return learners to some kind of table of contents 
to use as a branching point to interact with other parts of 
the sequence.

As with the response option buttons mentioned in the 
previous section, any shape or image can function as a 
navigation button and can be added using the previously 
described steps. Instructors may also insert one of Pow-
erPoint’s preset action buttons or insert a separate icon. 
The steps for adding buttons are shown in Tables 7 and 8 
Figs. 11 and 12.

Once all of the navigation buttons have been inserted, they 
should each be linked to different slides in the sequence. If 
using action buttons, the links will have been automatically 
inserted. If using shapes, images, or icons, use the steps for 

Fig. 8  Moving an object in front of other objects on a slide
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Fig. 9  Visual depictions of 
nonlinear, linear, and branching 
arrangements of programmed 
instruction
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Table 6  Adding hyperlinks

The “Slide . . .” option referred to in step 5 should be selected over the “Previous” or “Next” options as 
doing so will preserve the link to the specifically selected slide even if additional slides are inserted or 
other slides are removed

Step Description

1. Click on an object that is to serve as a response option button.
2. Click on the Insert tab at the top of the screen (Fig. 10).
3. Click the “Action” button.
4. In the Action Settings window that appears, click the “Hyperlink to”: option.
5. In the dropdown menu, select the “Slide . . .” option.
6. In the Hyperlink to Slide window that appears, select the desired slide that learners will be 

sent to when the click they object. Then click the “OK” button.
7. Repeat these steps for any remaining objects that are to function as response option buttons.

Fig. 10  Adding hyperlinks to 
objects

Table 7  Adding an action button

Step Description

1. Click the “Shapes” button in the toolbar (Fig. 11).
2. Scroll to the bottom of the Shapes menu to the Action Buttons section and select the desired button (e.g., the 

“Back” action button is the option with the left-facing triangle).
3. Click and hold down the mouse or keypad button and drag the cursor to draw the action button to the desired size.
4. Click the shape once more, and then in the Action Settings window that automatically appears, select “Slide . . .” 

from the “Hyperlink to”: dropdown menu, and select the specific slide that the action button will be linked to.
5. Click the “OK” button.

Table 8  Adding an icon as a 
button

Step Description

1. Click the Insert tab at the top of the screen (Fig. 12).
2. Click the “Icons” button in the toolbar.
3. In the icon window that appears, type the name or description of the kind of icon you would like 

to insert and press the “Enter” key on the keyboard.
4. Click the icon(s) you would like to use from the list of options that appear following the search. 

This will result in a checkmark appearing next to the icon indicating that it has been selected.
5. Click the “Insert” button.
6. Adjust the size of the icon by clicking and dragging the edge of the icon on the formatting outline.
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adding hyperlinks to objects described in the previous sec-
tion. As previously mentioned, “Back” buttons should be 
linked to the previous content slide, “Next” buttons should 
be linked to the next content slide in the sequence, “Close” 

buttons should be linked to the content slide that the feedback 
slide was linked to, and “Home” buttons should be linked to 
some menu initially displayed near the start of the instruc-
tional sequence.

Fig. 11  Inserting action buttons

Fig. 12  Inserting icons
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Adding Audio

In order to further simulate a synchronous learning expe-
rience, audio narration may be added to the instruction 
sequence. This audio can either be pre-recorded and then 
added into the PowerPoint slides, or it can be recorded 
directly within PowerPoint. The standard built-in micro-
phone on most personal computers may be sufficient to 
record audio; however, instructors are encouraged to use an 
external microphone or headset for better quality and clar-
ity, as well as to create a more professional product. The 
steps for inserting audio narration can be found in Table 9 
Figs. 13, 14 and 15.

At this point, the inserted audio will begin playing as 
soon as the slide appears. However, instructors can also 
add custom “Play” and “Pause” buttons for the audio using 
the steps in Table 10 Figs. 16 and 17.

Adding Subtitles

In order to make asynchronous instructional sequences 
more accessible for a wider variety of learners, instruc-
tors are encouraged to include subtitles to textually display 
any inserted audio (Americans with Disabilities Act, 1990; 
National Deaf Center on Postsecondary Outcomes, 2020). 
There are currently two approaches within PowerPoint for 
creating subtitles within individual slides. The first of these 
involves utilizing PowerPoint’s auto-generated subtitle set-
ting. Though initially developed to generate subtitles dur-
ing live, synchronous presentations, it can be utilized for 
asynchronous presentations as well under certain conditions. 
This feature, which is currently only available with Power-
Point for Microsoft 365, works by listening for any spoken 
audio, then automatically transcribing said audio and dis-
playing it on the computer screen in real time. Although this 

Table 9  Adding audio narration

Step Description

1. Click on the Insert tab at the top of the screen (Fig. 13).
2. Click the “Audio” button that appears.
3. If uploading pre-recorded audio to the slide, select the “Audio on my PC” option. In Microsoft PowerPoint for Mac, select the “Audio 

from File” option.
4. If recording audio directly in PowerPoint, select the “Record Audio” option (Fig. 14).
4a. In the Record Sound window that appears, click the circle record button, then speak directly into the microphone until the audio for that 

slide is complete.
4b. If an error is made during the recording, click the square stop button, then click the circle record button once more to record over the 

original recording.
4c. Once the recording is complete, click the “OK” button. You will know when your audio has been added when a speaker icon appears on 

the screen.
5. Click the speaker icon, then click the Playback tab that appears at the top of the screen (Fig. 15).
6. Click on the dropdown menu next to the “Start”: section on the toolbar, then select “Automatically.” This will result in your audio imme-

diately playing once the slide begins.
7. Click the “Hide During Show” check box so that the speaker icon is not visible to learners while they are completing the instructional 

sequence.
8. Repeat these steps to insert audio onto all remaining slides.

Fig. 13  Inserting audio into a slide
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method is easy to use, instructors should keep in mind that 
these subtitles are not always accurate. Furthermore, these 
subtitles may be limited or even disrupted if the device the 

learner is viewing the presentation on does not have a decent 
microphone, or if there is significant ambient background 

Fig. 14  Recoding audio directly into a slide

Fig. 15  Adjusting when inserted audio begins on a slide

Table 10  Adding custom play 
and pause buttons

In PowerPoint for Mac, there is no “Add Animation” button. Instead, just repeat steps 5–7 but select the 
“Pause” option in the Animation toolbar and select as the trigger the icon or shape that is to serve as the 
pause button

Step Description

1. Insert the object, shape, icon, or textbox that you would like to serve as your “Play” button 
using the previously described steps. Repeat with the object you would like to serve as 
your “Pause” button.

2. Click on the speaker icon on the slide.
3. While the speaker icon is selected, click the Animation tab at the top of the screen (Fig. 16).
4. Click the “Play” option on the left side of the toolbar.
5. Click the “Trigger” option on the right side of the toolbar.
6. In the dropdown menu that appears, select the “On Click of” option.
7. Select the object you would like to serve as your “Play” button from the list of objects.
8. Once the “Play” button trigger has been established, click the “Add Animation” button and 

select the “Pause” option from the menu (Fig. 17).
9. Repeat steps 5–7 using the object you would like to serve as your “Pause” button.
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noise. The steps for using the live subtitles setting can be 
seen in Table 11 Fig. 18.

The other approach, usable for all versions of Pow-
erPoint, involves manually adding subtitles as animated 
textboxes. With this method, instructors can specify 

exactly what each of the subtitles say, and the subtitles do 
not rely on any microphone. However, manually adding 
subtitles can be a lengthy and tedious process, as subti-
tles for each slide must be individually inserted and then 
independently animated so that their occurrence matches 

Fig. 16  Creating a custom play button

Fig. 17  Creating a custom pause button

Table 11  Using live auto-
generated subtitles

Step Description

1. Click on the Slide Show tab at the top of the screen.
2. On the right-hand side of the toolbar, click the “Always Use Subtitles” checkbox (Fig. 18).
3. Click the “Subtitle Settings” button in the toolbar.
4. Select desired spoken language (i.e., the language the audio is in) and desired subtitle language.
5. Select the location on the screen in which you would like the subtitles to appear (i.e., bottom, 

top, below slide, above slide).
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the occurrence of the corresponding audio. The steps 
for inserting subtitles using textboxes can be found in 
Table 12 Figs. 19, 20 and 21.

Disabling Slideshow Navigation

A key aspect of the initial teaching machines was the 
requirement to emit a response before progressing to the 
next frame. Subsequent programmed workbooks attempted 

Fig. 18  Activating automatically generated subtitles. Note. These are only available in PowerPoint for Microsoft 365

Table 12  Manually inserting subtitles using textboxes

In PowerPoint for Mac, there is no downward arrow to click. Instead, the Timings option will already be available in the Animation Pane. In 
addition, there is no “Add Animation” button. Instead, just click the “Exit Effects” button to add another animation and select the “Disappear” 
option

Step Description

1. Insert and format a textbox using the steps described earlier. Type the specific text in the textbox.
1a. Depending on how much audio there is on the slide, separate the subtitles so that it is displayed across multiple textboxes. This will avoid 

the need for large textboxes on the screen that might obscure any content being displayed on the slide.
1b. The textboxes should be formatted such that it is clear they are subtitles rather than part of the slide itself. This can be done by changing 

the font to something different from the rest of the slide, by creating a designated and signaled space on each slide for subtitles, or by 
placing a background color on the textboxes to simulate the look of closed captioning.

2. Click the textbox once to select it.
3. Click the Animations tab at the top of the screen (Fig. 19).
4. In the toolbar, select the “Appear” entrance effect (or any other desired entrance effect).
5. Click the “Animations Pane” on the right-hand side of the toolbar.
6. In the Animation Pane that appears on the right side of the screen, click the black downward arrow of the textbox label that you would like 

to animate.
7. In the dropdown menu that appears, select the “Timing . . .” option.
8. In the Start section of the Appear window, select the “With Previous” option from the dropdown menu (Fig. 20).
9. In the Delay section of the Appear window, set the time when the text should appear on the screen followed by the “OK” button.
10. Click the same textbox again to select it and make sure the Animations tab is still activated.
11. In the toolbar, click the “Add Animation” button (Fig. 21).
12. Select the “Disappear” option from the selection of Exit Effects near the bottom of the Add Animation window.
13. Repeat steps 5–9 to set when the text should disappear from the screen.
14. Repeat all of the previous steps until textboxes for all parts of the slide’s subtitles have been added and their entrance and exit times have 

been set.
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to impose this requirement through instructions and rules 
to respond before moving on, though there was not a 
true contingency for doing so. The standard PowerPoint 
slideshow also shares this limitation, as learners can 
advance slides using their keyboard or mouse. However, 
the responding-before-progressing requirement can be 
included into any instructional sequence in PowerPoint by 
setting the slideshow to present in kiosk mode. Doing so 
deactivates the built-in slide navigation while allowing any 
hyperlinked objects (e.g., the custom “Back” or “Next” 
buttons described in the previous sections) to continue to 
function. The steps for activating kiosk mode can be found 
in Table 13 Fig. 22.

Once the kiosk mode has been activated, the final step 
is to save a copy of the PowerPoint slides as a PowerPoint 
Show file (.ppsx) instead of the standard PowerPoint Pres-
entation file (.pptx or .ppt). By making this version of the 

file available, learners are only able to open your lesson 
as a slideshow rather than as a working, editable file. The 
steps for saving as a PowerPoint Show file can be found in 
Table 14 Fig. 23.

Discussion

The purpose of this article was to showcase how Power-
Point can be creatively utilized beyond the standard slide-
show presentation to teach learners in a manner consistent 
with behavior analytic instructional methods. PowerPoint as 
a medium is particularly useful because it is a cost-effective 
and common software program. Because of this ubiquity, 
PowerPoint also has a comparatively small learning curve, 
allowing more instructors to utilize it more quickly. Further-
more, instructional sequences created through PowerPoint 

Fig. 19  Adding closed caption entrance animation

Fig. 20  Adjusting the entrance or exit times of closed captions



 Behavior Analysis in Practice

Fig. 21  Adding closed caption exit animation

Table 13  Activating kiosk 
mode

Step Description

1. Select the Slide Show tab at the top of the screen (Fig. 22).
2. Click the “Set Up Slide Show” button in the toolbar.
3. In the Set Up Show window that appears, select the “Browsed at a 

kiosk (full screen)” option in the Show Type section, then click the 
“OK” button.

Fig. 22  Disabling slideshow navigation by activating kiosk mode
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can be easily modified and customized for different learners. 
This modifiability further increases the ability for instructors 
to implement culturally responsive pedagogy, which Gay 
(2000) describes as “using the cultural knowledge, prior 
experiences, frames of reference, and performance styles 
of ethnically diverse students to make learning encounters 
more relevant to and effective for them” (p. 29). The use of 
culturally responsive pedagogy is not only important for cre-
ating more inclusive and accepting learning environments, 
but can also result in greater, more meaningful, and more 
sustained learning for members of targeted cultural groups 
(e.g., Kisker et al., 2012; Singelis et al., 2018).

At the level of instructional design and development, cul-
turally responsive pedagogy can involve surface structure 
elements such as the inclusion of images, music, symbols, 
examples, and audio in languages that are consistent with 
a given culture. The instruction can also incorporate deep 
structure elements such the use of culture-specific values as 
a means of enhancing motivations for learning, as well as 
expressing and explaining instructional content in a man-
ner that is commonly utilized within the targeted culture 
(see Resnicow et al., 1999, for a further description of sur-
face and deep structure). Specific to PowerPoint, instruc-
tors could create a base or skeletal instructional sequence 
and then, in collaboration with members of specific cultural 

communities, use the “Save As” feature to create additional 
and more individualized culturally responsive versions of 
each sequence.

Instructors utilizing PowerPoint can also explore a variety 
of active responding options outside of the standard multi-
ple-choice format. As is common in instruction for concept 
formation, learners could be presented with different depic-
tions of a topic or concept in action and then select whether 
the description represents an example or a nonexample of 
the topic (Layng, 2019). A similar approach could be taken 
by providing correct and incorrect versions of key defini-
tions and having learners make the appropriate identifica-
tion. Going beyond such discrimination practice, instruc-
tors could include descriptions of incorrect procedures being 
implemented and then have learners select specific aspects 
in the descriptions that are incorrect. Furthermore, instruc-
tors could present incorrect or incomplete descriptions of 
procedures or processes being implemented and then have 
learners select the missing steps or components from a list.

Though PowerPoint does offer a surprisingly flexible 
instructional platform, it is not without its limitations. 
From an active responding standpoint, learners’ responses 
are limited to mouse clicks, which may not be the optimal 
response form for learning certain topics. In situations where 
responses need to be written or constructed (e.g., stating def-
initions) or for topics that require the demonstration of larger 
repertoires (e.g., conducting a procedure), PowerPoint-deliv-
ered instruction will likely need to be supplemented with 
additional response opportunities separate from those of the 
instructional sequence.

From a user-experience standpoint, PowerPoint currently 
does not provide a mechanism for learners to save their place 
within the instructional sequence. That is, if they are unable 
to finish the lesson in one sitting, they will either have to 
keep the program open until they are able to complete it, 
or they will have to start again from the beginning if the 

Table 14  Saving as a PowerPoint show file

Step Description

1. Click the Files tab at the top of the screen.
2. Select the “Save as” option (Fig. 23).
3. Click the file format dropdown menu to open a 

list of available file types.
4. Select the “PowerPoint Show (*.ppsx)” file type.
5. Click the “Save” button.

Fig. 23  Saving a presentation as a PowerPoint show file
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program is closed. This, in some ways, limits the schedule 
flexibility often favored by those who complete online or 
hybrid courses.

Finally, instructional sequences created in this manner 
require significant time and response effort to fully develop 
such material and ensure everything works as it should, and 
many academic departments and instructors might not have 
the availability to allocate such substantial resources toward 
this endeavor. The time investment is a common critique 
for behavior analytic instructional methods, though it can 
be argued that the overall time investment is not substan-
tially more than instruction prepared and delivered in more 
traditional ways. In fact, well-developed asynchronous 
instruction may actually save time in the long run because 
instructors do not need to spend time actually delivering 
the lessons, and learners may ultimately require less addi-
tional remediation or clarification if they leave each lesson 
with a better understanding of the material presented. The 
long-term time-saving aspect may be particularly beneficial 
for practitioner training in clinical or applied settings where 
training is often condensed or incomplete due to time and 
resource limitations associated with live training, as well as 
frequent limited availability of personnel to actually conduct 
the trainings. Furthermore, once the instructional sequences 
have been created, they can be used repeatedly with future 
learners and easily updated and modified as necessary.

As instructional technology continues to advance, and as 
asynchronous instruction becomes more widely utilized, a 
common concern is that it will eliminate the role of a live 
teacher or instructor. Although some educational organiza-
tions are likely to take that approach as a cost-saving meas-
ure, it is unlikely that teachers will ever be fully removed 
from the education process. For one thing, teachers serve 
an integral function beyond providing instruction, includ-
ing counselor, mentor, and support system for learners. 
Furthermore, as Keller (1968) postulated, it is possible that 
the instructional responsibilities of teacher will instead shift 
from an instruction-deliverer to something more akin to a 
behavior scientist; that is, they will be the ones to develop 
instructional material, analyze its effectiveness, and utilize 
data-based decision-making to adjust the instruction as 
necessary. Finally, given that many core repertoires involve 
more than verbal behavior, there will always be the need 
for some level of actual behavioral demonstration and cor-
responding individualized feedback. In an ideal situation, 
asynchronous instruction could be used to ensure learners 
attain certain prerequisite or component knowledge that 
instructors can then capitalize on to shape more sophisti-
cated repertoires. In this way, synchronous instructional 
time can become more efficient, and more learning can be 
achieved.
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